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Presidential Bits
by Geof Goodrum, President WACUG, president@wacug.org

The June meeting featured our semi-annual PC Clinic, a presentation by 
Lorrin Garson on free encryption software to keep your data secure, and 
an extended Questions & Answers panel session called “Hands On Help” 
where Paul Howard, Chuck Roberts, and I fielded a variety of questions 
from the audience. While the panel provided a lot of useful information, we 
still need an experienced Microsoft Outlook user to answer a question on 
recovering a contacts list lost during a Windows 7 upgrade.
Big thanks to our volunteer PC Clinic tech crew, Roger Fujii, Nick Wenri, 
and Scott Hanak, for helping our members with their computer issues!
Lorrin's briefing titled “Effortless Encryption for Anxious Users” is already 
posted as a PDF file on the WAC Recent Meetings web page (http://www.
wacug.org/recmtgs.html). Key points discussed during the briefing were that 
deleted files on a hard disk can still be read, passwords must be strong to 
be effective, and there are a number of freely available tools to protect your 
sensitive data even if your computer is stolen. The briefing has plenty of web 
links for more information. Thanks, Lorrin!
For the next meeting on July 17th, Thom Clement (Executive Director of 
OLLI), Tom Hady (OPCUG member), and Ernestine Meyer (OPCUG/
WACUG member) volunteered to tell us about their favorite Handheld De-
vices, specifically, RiM's Blackberry Tour, Apple's iPod Touch, and iPhone. 
We will use OLLI's new docucam system so everyone can get a clear view. 
Neal Grotenstein will provide the Learn 30 tutorial session on keeping your 
computer mouse clean and using compressed ZIP files within Microsoft 
Windows.
See you there. 


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Lloyd’s Web Sites for July, 2010
by Lloyd Johnson, WACUG Member 

http://www.wacug.org/ is the URL for the Washington Area Computer 
User Group. Visit it for past issues of Web Sites with hyperlinks.
1.	 Major League Baseball  for 2010 – www.forbes.com/mlb

2.	Options for remaining Anonymous while you surf the Web. A company 
called Anonymizer is a major provider for this type of service for $80 
per year. – www.anonymizer.com. Onion routing is another method; but 
very complicated – www.torproject.org

3.	Geni: Free Family Tree – www.geni.com – Geni is the fast, free, fun 
way to create your family tree with your relatives and stay in touch. Free 
unlimited photo and video sharing

4.	PetSide.com is the source of pet health information, pet news, pet care – 
www.petside.com

	HubbleSite: Out of the Ordinary — Out of this World – 5.	 http://hubble-
site.org "NASA's best-recognized, longest-lived, and most prolific space 
observatory zooms past a threshold of 20 years of operation this month. 
On April 24, 1990, the space shuttle and crew of STS-31 were launched 
to deploy the Hubble Space Telescope into a low Earth orbit. What fol-
lowed was one of the most remarkablesagas of the space age." Related site: 
Hubble Turns 20: A Retrospective in Pictures.
	Major Malls in Northern Virginia: 6.	
Ballston Common 4238 Wilson Blvd - Arlington, VA 22203; 703-415-
2400 – www.ballston-common.com 
Dulles Town Center 21100 Dulles Town Center - Dulles, VA 20166 
703-404-7120 – www.shopdullestowncenter.com 
Fair Oaks Shopping Center 11750 Fair Oaks - Fairfax, VA 22033 703-
359-8300 – www.shopfairoaksmall.com 
Fashion Center at Pentagon City 1100 South Hayes Street - Arlington, 
VA 22202 703-415-2400 – www.fashioncentrepentagon.com 
Landmark Mall 5801 Duke Street Alexandria, VA 22304 703-354-
8405 – www.landmarkmall.com 
Manassas Mall 8300 Sudley Road Manassas, VA 20109 703-368-0181 
– www.manassasmall.com 
Potomac Mills Mall 2700 Potomac Mills Circle - Prince  William, VA 
703-643-1770 – www.potomac-mills.com 
Reston Town Center 11921 Freedom drive - Reston, VA 703-689-4699 
– www.restontowncenter.com 
Springfield Mall 6500 Springfield Mall - Springfield, VA 703-971-3600 
– www.springfieldmall.com 
Tysons Corner Center 1961 Chain Bridge Road - McLean, VA 22102 
703-893-9400 – www.shoptysons.com 
Tysons II Galleria 2001 International Drive - McLean, VA 22102 703-
827-7700 – www.tysonsgalleria.com

	 USPS Domestic Postage Price Calculator – 7.	 http://postcalc.usps.gov



NCTCUG
Visit our “sister” user group. 
The National Capital Tech-
nology and Computer User’s 
Group meets the first and 
fourth Wednesday of the 
month. They meet in Carlin 
Hall in Arlington at 5711 
South 4th Street. Visit their 
web site for more informa-
tion, a map and directions:

h t t p : / / w w w. n c t c u g . o r g /

Meetings start at 7:00 PM

Washington Area User 
Group Partners

Working Together For 
Our Members

NCTCUG

WACUG

OPCUG
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See Linux page 4

GNU/Linux SIG
By Geof Goodrum, WACUG

Filling a Scanned Form with OpenOffice.org

This month I had to submit an architectural change request form to my hom-
eowner's association. Unfortunately, the association's management company 
only provided a scanned image of the required form in PDF format. Worse, 
the image was skewed. The normal procedure is to print a hardcopy of the 
PDF, then fill it in by hand and fax it, mail it or drop it off at the manage-
ment company (their offices are only open while I am at work, of course). Not 
very efficient, and I wanted to expedite the process by e-mail since I had a 
contractor waiting to begin work upon approval of the change.

After a Google search, I found the following link: http://www.linuxquestions.
org/questions/linuxquestions-org-member-success-stories-23/how-to-fill-
pdf-forms-even-read-only-%3B-better-than-acroread-v9-for-linux-796720/. 
The process only required the free ImageMagick graphic utility package and 
the OpenOffice.org Writer word processor, both included in most GNU/
Linux distributions. Below is a summary of the steps I followed; the web 
article provides more details.

To convert the PDF to a PNG image (and correct the image skew at the same 
time), I used the ImageMagick convert utility in an X terminal window:

convert -rotate 1.5 -monochrome -density 150 -resample 
150x150 form.pdf Output _ image.png

where form.pdf is the name of the input PDF form and Output_image.png 
is the name of the output PNG image file. I executed the command in  the 
same directory with the input and output files. The -rotate 1.5 option rotated 
the image 1.5 degrees clockwise to remove the skew in the image (nega-
tive values rotate counterclockwise). I found the right value through trial 
and error and the ImageMagick command line display Output_image.png 
to view the result. Since I was working with a black and white form, I used 
the -monochrome option. The author of the web article recommended the 
output density settings of -density 150 -resample 150x150, and these options 
worked well for me. You can find out more about ImageMagick options for 
convert by entering info convert in the terminal, or visit the ImageMagick 
web site at http://www.imagemagick.org/script/index.php.

Once I had a good PNG image of the form, I created a new document in 
OpenOffice.org Writer and imported the image. As described by the author, 
this was accomplished by simply using the menu items Insert > Picture > 
From File, and selecting the Output_image.png file. I resized the form im-
age to fit the page borders appropriately, then followed the author's directions 
by right-clicking on the image, selecting Anchor > To Page, then Wrap > 
In Background. Click outside of the image (along the page border), then 
proceed to enter text on top of the form image, adjusting layout as necessary 
(adjust borders, font size, line spacing, etc.) to fit the form.

http://www.linuxquestions.org/questions/linuxquestions-org-member-success-stories-23/how-to-fill-pdf-forms-even-read-only-%3B-better-than-acroread-v9-for-linux-796720/.
http://www.linuxquestions.org/questions/linuxquestions-org-member-success-stories-23/how-to-fill-pdf-forms-even-read-only-%3B-better-than-acroread-v9-for-linux-796720/.
http://www.linuxquestions.org/questions/linuxquestions-org-member-success-stories-23/how-to-fill-pdf-forms-even-read-only-%3B-better-than-acroread-v9-for-linux-796720/.
http://www.imagemagick.org/script/index.php
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Linux from page 3

Once I was satisfied with the results, I selected File > 
Save As to save a copy of the completed form for my 
records and as a template for future use, then File > 
Export as PDF to create a PDF file to e-mail to the 
property manager. The resulting single page filled-in 
PDF form was only about 34 kilobytes and quite ad-
equate for the purpose.
With that said and done, the better long-term solution 
is to recreate the form from scratch using OpenOf-
fice.org Writer or the Open Source Scribus desktop 
publishing software (http://www.scribus.net/), both 
of which can create PDF forms that can be filled in 
and saved directly with the appropriate PDF reader 
software. I can then provide the fillable PDF form to 
the management company for others to benefit from, 
but that's a project for another day.

GNU/Linux Distribution Releases

GNU/Linux distributions are bundled collections of 
software including a set of applications and an op-
erating system built on the Linux kernel. Some dis-
tributions include general applications such as office 
suites, music players, and web browsers, while others 
may have specific purposes such as computer system 
recovery, network firewall, media center, or gaming. 
Individuals, community projects, or businesses create 
distributions. While some distributions are commer-
cial and include fee-based technical support, other 
distributions are freely downloadable or can be or-
dered on CDs or DVD at low cost.

WAC can provide CD-R and DVD±R media for any 
downloadable GNU/Linux operating system dis-
tribution (e.g. Fedora, Mandriva, Ubuntu, Debian, 
Knoppix). Please note that downloadable distribu-
tions do not include official technical support nor 
printed documentation.  Single CD-R discs are avail-
able with a $3 donation; GNU/Linux distributions 
on multiple CD-Rs or single DVD±R are available 
with a $6 donation. Discs are available only by pre-
order. Contact Geof Goodrum by e-mail (linux@
wacug.org) at least 48 hours before meeting day to 
order or for more information.

DistroWatch.com lists the following distribution 
release announcements for the period June 3 – 30, 
2010.

Distribution
Absolute Linux 13.1.1
Greenie Linux 7L
KANOTIX 2010
linuX-gamers Live 0.9.6
MoLinux 6.0
Pardus Linux 2009.2
Parted Magic 4.11
Peppermint OS One-06172010
Quirky 1.2
Sabayon Linux 5.3
Sabayon Linux 5.3 "SpinBase", 
"CoreCDX"
Sabily 10.04
Salix OS 13.1
Scientific Linux 5.5 "Live CD/DVD"
sidux 2010-01
Superb Mini Server 1.5.2
Syllable Server 0.4
SystemRescueCd 1.5.6
Ultimate Edition 2.7
Untangle Gateway 7.3
VortexBox 1.4
wattOS R2
Ylmf OS 3.0
Zenwalk Linux 6.4 "Core"
Zenwalk Linux 6.4 "GNOME"
Zorin OS 3

Linux Software of the Month
The software described below is downloadable at the 
links provided or copied onto a USB flash drive at the 
WAC meeting.
June 2010
GoogleCL – v0.9.7. http://code.google.com/p/google-
cl/. Free Apache 2.0 License source code and Debi-
an/Ubuntu package by the GoogleCL Project Team. 
GoogleCL provides a command line interface to 
Google online services, including Blogger, Calendar, 
Contacts, Docs, Picasa, and YouTube. For example, 
create a Google Calendar entry with google calendar 
add "Lunch with Jim at noon tomorrow" and create 
a new Picasa photo album online with google picasa 
create --title "Cat Photos" ~/photos/cats/*.jpg. Goo-

See Linux page 5

http://www.scribus.net/
mailto:linux@wacug.org
mailto:linux@wacug.org
http://distrowatch.com/?newsid=06129
http://distrowatch.com/?newsid=06141
http://distrowatch.com/?newsid=06128
http://distrowatch.com/?newsid=06127
http://distrowatch.com/?newsid=06152
http://distrowatch.com/?newsid=06115
http://distrowatch.com/?newsid=06137
http://distrowatch.com/?newsid=06153
http://distrowatch.com/?newsid=06119
http://distrowatch.com/?newsid=06120
http://distrowatch.com/?newsid=06143
http://distrowatch.com/?newsid=06143
http://distrowatch.com/?newsid=06156
http://distrowatch.com/?newsid=06116
http://distrowatch.com/?newsid=06146
http://distrowatch.com/?newsid=06135
http://distrowatch.com/?newsid=06150
http://distrowatch.com/?newsid=06126
http://distrowatch.com/?newsid=06145
http://distrowatch.com/?newsid=06121
http://distrowatch.com/?newsid=06114
http://distrowatch.com/?newsid=06117
http://distrowatch.com/?newsid=06151
http://distrowatch.com/?newsid=06118
http://distrowatch.com/?newsid=06147
http://distrowatch.com/?newsid=06133
http://distrowatch.com/?newsid=06131
http://code.google.com/p/googlecl/
http://code.google.com/p/googlecl/
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gleCL requires Python 2.5 or 2.6 and python-gdata 
>= 1.2.4 (preferably 2.0.x).

Iron – v4.0.275.2 (executable), v5.0.381 (source). 
http://www.srware.net/en/software_srware_iron_
download.php. Free BSD License source code 
and executable by SRWare. Iron is a version of the 
Google Chrome web browser modified to remove 
features that could compromise privacy, including 
unique browser ID, timestamp when the browser was 
installed, an encoded string sent with all queries to 
Google, and redirections to Google on address errors 
and server not found.

Scan Tailor – v0.9.9.1. http://scantailor.sourceforge.
net/. Free GNU General Public License source code 
by Joseph Artsimovich. Scan Tailor is an interactive 
post-processing tool for scanned pages. It performs 
operations such as page splitting, deskewing, adding/
removing borders, despeckling, and others. You give 
it raw scans and you get pages ready to be printed or 
assembled into a PDF or a DJVU file.

The Butterfly Effect – Milestone 7. http://source-
forge.net/apps/trac/tbe/wiki. Free GNU General 
Public License source code and Linux installer by Pe-
ter van Ginneken and Klaas van Gend. The Butterfly 
Effect (TBE) is a physics game about cause and ef-
fect. You build complex mechanical systems using le-
vers, rocket-like cola bottles and ordinary objects like 
tennis balls and bikes to accomplish simple tasks like 
toppling a Bowling Pin. This is also known as a Rube 
Goldberg machine or a Heath Robinson contraption. 
This type of game was pioneered by the game series 
The Incredible Machine in the 1990s. TBE is still 
in active development, but this beta quality release 
includes 30 playable levels.

Kernel Source – v2.6.34. http://www.kernel.org/. 
Free GNU Public License source code for all plat-
forms by the Linux community. 



Linux from page 4

Several Screen shots from Geof's article 
follow on the next two pages...	

Handheld Tech Presentations

Tom Hady:  The iPod touch is an iPhone mi-
nus the phone and a few other features.  This 
note is an example of one use.  It comes to you 

from my hotel room in Boston, typed on my itouch.   
I’ll explain some of the other uses at the meeting.
Blackberry Tour, model 9630
The Blackberry Tour is considered “top of the line” 
among the Blackberry models. It is considered a 
“smart phone” because it can multi-task:

search and view web pages on the Internet•	
communicate via multiple email accounts•	
end/receive text and picture messages•	
take pictures and videos and share them•	
use GPS technology to get directions, view •	
maps, or locate specific addresses, businesses, or 
landmarks
Make and receive phone calls internationally•	

Blackberries are best known for the ease with which 
you can receive and send emails.   The Tour model 
uses the full QWERTY keyboard with small push 
buttons.  This is the primary reason I chose the 
Blackberry rather than one of the touch-screen smart 
phones.
 http://worldwide.blackberry.com/blackberrytour/
ndsp2.jpg

http://www.srware.net/en/software_srware_iron_download.php.
http://www.srware.net/en/software_srware_iron_download.php.
http://scantailor.sourceforge.net/
http://scantailor.sourceforge.net/
http://sourceforge.net/apps/trac/tbe/wiki
http://sourceforge.net/apps/trac/tbe/wiki
http://www.kernel.org/
http://worldwide.blackberry.com/blackberrytour/ndsp2.jpg 
http://worldwide.blackberry.com/blackberrytour/ndsp2.jpg 
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Scan Tailor (Deskew)

Scan Tailor (Split Pages)
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The Butterfly Effect 

The Butterfly Effect 
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Verbatim Nano Wireless 
Mouse
Reviewed by Fred Wassermann, Vice President, 

Programs
Seniors Computer Group, California

December 2009 issue, Bits and Bytes
www.scgsd.org / scgsd (at) cox.net 

I just installed a new Verbatim Nano wireless 
mouse in my notebook computer. I had used an-
other brand of wireless mouse which had a typi-

cal 2-inch long wireless receiver. It was satisfactory 
but because I had 
to remove the 
USB receiver 
to fit it into the 
carrying case, it 
was not ideal. 
It also worried 
me somewhat 
as I had already 
damaged two 
thumb drives 
on my desktop 

computer as well as destroying one USB female sock-
et on that computer. Well, I damaged the one and 
my 75 pound dog did the other one. I learned but he 
didn’t. You can see one totaled thumb drive below. It 
doesn’t take much to kill one.
This got me thinking about possible damage to the 
wireless mouse receiver dongle as well as the pos-
sibility of damage to the notebook motherboard if 
anything bumped it or dropped on it. Replacement 
receivers are about half the cost of the whole mouse 
setup. Motherboards are very expensive to replace on 
notebooks. If you look at the Verbatim Nano Mouse 
in the figures at the top 
and bottom right, you 
can see that the receiver is 
extremely small. It barely 
projects ¼ inch from the 
computer. It is just big 
enough to be removable 
with thumb and forefin-
ger. It is not likely to be 
in the path of anything 
that can break it. Problem solved, worry gone, and 
my notebook can be packed even with the receiver 
attached.

How does this mouse compare with other units? At a 
suggested list of $29.95, it is the least expensive wire-
less mouse sold with a tiny receiver dongle like this 
one. Similar Nano mice are considerably more expen-
sive. The mouse is small, perfectly sized for your note-
book, yet quite adequate for the average hand. A rub-
berized grip makes for easy handling. The Nano has 
the standard two buttons along with a programmable 
scroll wheel but no extra programmable function but-
tons. Of course, the included software allows left- or 
right-hand use. I found that extra mouse buttons are 
often accidentally clicked when those functions are 
least desired. This mouse shuts off to save batteries 
when not in use. It is not an issue with notebook us-
ers, but in my tests, the receiver worked flawlessly 
at ranges greater than 10 feet from the mouse, well 
beyond where one can see the cursor on the screen. 
My present desktop wireless mouse has the stutters 
when it is only 4 feet from the computer. That can be 
an issue when a desktop unit is as distant from the 
mouse as mine is. This would not be a problem with 
the Verbatim Nano.
Another consideration for those that have built-in 
Bluetooth in their notebook, this mouse is also avail-
able in a Bluetooth unit, requiring no dongle at all. 
Same price, same functionality.
The Verbatim Nano Mouse functions better than 
any wireless mouse I have owned. It has very good 
resolution, offers significant protection from bump-
ing damage due to the small size of the receiver, is 
less expensive than comparable products, and comes 

in six colors. I am partial to red.  
If you have a notebook, I recommend this product. 
If you just have a desktop unit I recommend it as a 
worthwhile accessory. Wireless has come a long way 
with this product. More info is available at: http://ti-
nyurl.com/29sww5k



www.scgsd.org / scgsd@cox.net
http://tinyurl.com/29sww5k 
http://tinyurl.com/29sww5k 
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Indenting Cell Contents
Microsoft Excel allows you to format the contents of 
a cell in a myriad of ways. One of the formatting op-
tions you can apply is to indent the contents of a cell 
by a certain amount. This is similar to indenting done 
in a word processor, such as Microsoft Word, except 
that the indenting is specified in a number of charac-
ters, not in a linear distance such as inches or points.
To set the indent to be used in a cell, follow these 
steps:
1.	 Select the cells you want to format.
2.	 Display the Format Cells dialog box. (In Excel 

2007 display the Home tab of the ribbon and 
click the small icon at the lower-right corner of 
the Number group. In older versions of Excel 

choose Cells from the Format menu.)
3.	 Make sure the Alignment tab is selected.
4.	 In the Horizontal drop-down list, choose Left 

(Indent). If you are using Excel 2002 or a later 
version, you can also choose Right (Indent).

5.	 Using the Indent control, specify the number of 
characters by which the cell contents should be 
indented from either the left or right side of the 
cell. You can pick any whole number between 0 
and 15.

6.	 Click on OK.
Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted by 
permission. Thousands of free Microsoft Excel tips can be found 
online at http://excel.tips.net.

The Alignment tab of the Format Cells dialog box.

Inserting a Non-Breaking 
Hyphen
When Microsoft Word calculates line length and 
wraps text to the next line, it tries to wrap (or break) 
the line at a space or a hyphen—a dash. Sometimes, 
however, you may not want Word to break a line at 
a dash. For instance, dashes are used in telephone 
numbers, and you might not want a line to break in 
the middle of a telephone number.
The answer is to use non-breaking hyphens instead 
of regular dashes when you don’t want Word to break 
a line at the hyphen. To do this, hold down the Ctrl 
and Shift keys as you type the dash (this is the same 
as typing Ctrl and an underscore). Word will then 
not break the line at that point.
You can also insert a non-breaking hyphen by 
following these steps:

1.	 Choose Symbol from the Insert menu or, in 
Word 2007, display the Insert tab of the ribbon, 

click Symbol in the Symbols group, and finally 
click More Symbols. This displays the Insert 
Symbol dialog box.

2.	 Click on the Special Characters tab.
3.	 Highlight the Nonbreaking Hyphen character.
4.	 Click on Insert.
5.	 Close the dialog box by clicking on Cancel.
Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted by 
permission. Thousands of free Microsoft Word tips can be found 
online at http://word.tips.net.

The Special Characters tab of the Symbol dialog box.

MS Office Tips 
Provided by Sharon Parq Associates
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Virtual Magnifying Glass 3.3.2 
A free, open source, screen 
magnifier, for Windows, Linux, 
FreeBSD and Mac OS X

By Jim Townsend, Managing Editor, Brevard User 
Group, Florida

The Bug Newsletter, May 2010 Issue
www.bugclub.org / newsletter (at) bugclub.org

Awhile ago I installed this program on my 
notebook computer, tried it out and forgot 
about it. I started to cleanup and defrag the 

hard drive and came across it.
So of course I had to play with it. The notebook has an 
LCD screen with 1280x800 resolution and some sites 
are hard to read with fine print, colored backgrounds 
and the dimming when it is on battery power.

When you click on the program to open it you have 
four choices to pick from, one of which is the web site. 
I clicked on that and read the instructions. Simple 
and to the point, “even a caveman could do it.” Once 
the program is started, you can click the mouse and 
it will drop to the system tray on the task bar, where 
you can bring it up when needed. After a reboot you 
will have to restart the program again, so a shortcut 
on the desktop would be convenient.
The program defaulted to a 3x5 inch box, which I 
found could easily be changed, also with different 
levels of magnification. You could change the width 
to read a line of text and three or four lines in height, 
then just drag the box down the page.
Did I mention it was FREE. The author asks for a 
donation through PayPal; if you find it useful please 
consider paying something.
http://www.magnifier.sourceforge.net



www.bugclub.org
http://www.magnifier.sourceforge.net


The Cursor — July 17,  2010 Page 11  — www.wacug.org

The Cursor
	 Copyright ©2010 WACUG	 Monthly Circulation: 60

The 2010 WAC Board of Directors, SIG Leaders and other Volunteers
	 Directors:
President:........................................................ Geof Goodrum, 703-370-7649, ggoodrum(at)bigfoot.com
Vice-President:............................................... Paul Howard, 703-860-9246, plhoward(at)verizon.net
Secretary:........................................................ Bill Walsh, 703-241-8141, bill.walsh(at)cox.net
Treasurer:....................................................... Bob Rott, b1bob1b(at)cox.net
Newsletter Editor........................................... Chuck Roberts, 703-876-9787, chrobe(at)verizon.net
Registered Agent:........................................... Jorn Dakin, 703-534-8691, Idakin(at)alumni.uchicago.edu
Member at Large:........................................... Jim Brueggeman, 703-450-1384, bigjimo1(at)aol.com
Member at Large:........................................... Mel Mikosinski, 703-978-9158, melvin22003(at)aol.com
Member at Large............................................ Lorrin R. Garson, garson9929(at)yahoo.com
Member at Large............................................ Neal Grotenstein, 240-938-6381, mc4359(at)yahoo.com
	 Volunteers:
Linux SIG Leader, Membership Chair:........ Geof Goodrum, 703-370-7649, ggoodrum(at)bigfoot.com
Internet Columnist:....................................... Lloyd Johnson, lloydhj(at)aol.com
Vendor Contact:............................................. Chuck Roberts, 703-876-9787, chrobe(at)verizon.net
Web Site Team: .............................................. Paul Howard and Chuck Roberts
Meeting Setup:............................................... Bill Walsh, 703-241-8141, bill.walsh(at)cox.net
APCUG Liaison: ....................................... Gabe Goldberg, gabe@gabegold.com

Send membership inquiries and address changes to: membership@wacug.org
Send article submission and reprint requests to the Editor: cursor@wacug.org

WAC Membership/Renewal Application
Dues are collected on an Annual basis and includes: 
downloadable links for WAC’s monthly newsletter, 
The Cursor, in PDF format

Individual/Corporate/Family Dues: $25.00  
$5 annual surcharge for delivery of the Cursor by 
1st Class mail

Remit payment in person at the WAC Membership 
table on meeting day, or by mail to:
Washington Area Computer User Group
30 Fendall Ave.
Alexandria, VA 22304-6300
Make checks payable to WAC. Please do not send 
cash by mail.   Thank you for joining WAC!
Complete if you name and address do not appear 
on the reverse side. Include E-mail Address
Name:
Street:
City:
State:			   Zip:
Phone:  (        )          –

E-mail: 
Membership Survey: Help us to help you by completing this survey.
List the computer systems you own / use (in order of preference)

Operating System(s):

Modem(s):

Printer(s):

Other Hardware:
Favorite Software:
Connection: (circle one) 	 Dial-up     or  	 Broadband

Circle Your Interests:	 Photo Printing	 Investing	 Games
Digital Photography	 Internet Access	 Education	 Music
Graphics/Animation	 Genealogy	 Video	 Finance
Programming Language(s)
Hardware Upgrades/Repair	 List others below

The Cursor is the official publication of the Washington Area Computer User Group (WACUG), a Virginia membership corporation. WACUG 
is a tax exempt organization under section 501(c) (3) of the Internal Revenue Code. Contributions are encouraged and are tax deductible. All 
material is Copyright © 2010 by the Washington Area Computer User Group unless otherwise specified. Products or brand names mentioned 
may be trademarks or registered trademarks of their respective owners. The contents of articles herein are the responsibility of the authors and 
do not necessarily represent the Washington Area Computer User Group, the Board of Directors, or its members.

The Cursor provides news, commentary and product information to members of the Washington Area Computer User Group.



Washington Area Computer User Group
30 Fendall Avenue
Alexandria, VA 22304-6300
ADDRESS CORRECTION REQUESTED

FIRST-CLASS MAIL

Label

Stamp

All Meetings are held at the 
Osher Lifelong Learning In-
stitute 4210 Roberts Road, 
Fairax, VA. Call our help 
line or visit our web site if 
you need additional infor-
mation.

FREE ADMISSION
BRING A FRIEND!

Service Desks Open at 
12:30 Meeting Starts at 

1:00 PM
FREE ADMISSION
BRING A FRIEND!

Next WAC Meetings:	 • Jul 17	 • Aug 14	 • Sep 14	 • Sep 18	 • Oct 16
Call (703) 370-7649 for the latest meeting information or Visit our Web Site at:

http://www.wacug.org 

TIME-SENSITIVE MATERIAL
Please Deliver By

July 9, 2010



The Cursor — July 17,  2010 Bonus Page 1  — www.wacug.org

See Slick Deals next page

The Slickdeals Approach to 
Cable Company Negotiations

By Gabe Goldberg, Computers and Publishing, Inc.
Slickdeals (at) gabegold.com

For some people, their cable company is “the compa-
ny they love to hate”. Most folks just accept the cable 
company for what it is, a semi-regulated utility pro-
viding useful or necessary services. And the remain-
der -- often to the mystification of the first group -- 
just love their company, even singing its praises when 
cable service is discussed.
To make sense of this variation, remember that cable 
service is generally provided by regional monopolies, 
with territories granted by local governments, so fea-
tures, customer services, and costs indeed vary wide-
ly. And even one company’s characteristics can vary 
with geography, depending on factors such as local 
management, franchise arrangements and fees, and 
infrastructure age and quality.
As early as possible in this process, request your free 
credit reports and ensure that you’re shown as being 
financially responsible, with all account payments up-
to-date. Felicia Blow, Cox Cable’s Director of Public 
Affairs, notes that the better a credit history is, “the 
more flexibility Cox has in avoiding the customer 
having to pay deposits and the like to get or restore 
service.”
But separate from everything else is the need to nego-
tiate effectively with the company, whether establish-
ing new service, changing what’s provided, or simply 
haggling for a better deal.
So, prior to any conversation or transaction, do your 
homework. Understand everything you’ll need to 
consider and perhaps mention: competition to cable 
services in your area (satellite and over-the-air TV, 
phone company DSL or FiOS, cell phone service), 
services offered, service levels (e.g., Internet connec-
tion speeds, TV channel bundles), features (telephone 
caller-id, voicemail, speed dialing, three-way calling, 
etc.), list prices, bundle discounts, and current or re-
cent promotions offered.
This is complicated enough that you want to get it 
right, selecting no more or less than what you need 
and want, while paying the best price possible. So 
start with a list (or, better, a spreadsheet) showing 
what to discuss, each item’s relative importance to 
you, the cable company’s quoted price, and any avail-

able bundles or promotions.
Just as a retired couple likely doesn’t need a seven-
passenger SUV and a young singleton won’t rent a 
McMansion, don’t get carried away by glittering 
features and services. Cox’s Blow suggests 
remembering your “station in life” before ordering 
the fastest Internet connection if you’ll just send 
email and do light Web surfing, though if you have 
far-flung family, a generous phone package might 
ultimately save money.
Similarly, a killer online gamer might go for 
blazing DOCSIS 3.0 Internet bandwidth and skip 
phone service entirely, depending on cell phone 
connectivity.
Bundles -- combination service packages costing less 
than the sum of their individual components -- can 
save or waste money. Think carefully about whether 
it’s worth spending more money to save some, or 
whether better value comes from mixing-and-
matching bits from multiple providers.
Consider freebies offered but remember that they 
only have value if they’re useful. Internet services 
may include spam filtering, security tools, parental 
controls, anti-virus, anti-spyware, etc., but compare 
their quality to other free and fee tools to ensure that 
you’re getting best of breed. If you won’t use them, 
don’t let a cable rep seduce you into paying premium 
prices because they’re included.
You’ll likely be offered prepaid protection for inside 
cable facilities. Unless you’re aware of problems, it’s 
usually best to decline this -- it’s essentially overpriced 
insurance against rare problems with cable wiring. 
The company is responsible for connectivity to your 
dwelling’s main termination, and will usually address 
(Internet, TV, phone) signal quality issues at no cost. 
But check with neighbors regarding company service 
and fee policies regarding inside work.
Once you’re a customer, you’re not done chatting with 
your CableCo. Don’t suffer service problems or billing 
issues silently, or just gripe to friends and neighbors. 
Cable companies understand they’ve had public 
relations problems and work to be better liked. Online 
services such as real-time customer service chats may 
resolve problems at 3 am. And some companies have 
online monitors watching for complaints in forums 
and on Twitter.
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Even satisfied customers benefit from occasionally 
evaluating services and adding/deleting features, 
and calling to request lower prices can cut monthly 
bills. This can involve citing competitive services – for 
example, if your neighborhood has just been wired 
for FiOS with promotional rates offered, you can 
threaten to terminate service unless the lower price 
is matched.
Make this more credible by mentioning that you’re 
not tied to CableCo email addresses; note that you 
use Webmail service accessible through any ISP 
or that you have your own domain (both of which 
are good practices to avoid having to change email 
addresses when moving from one company’s territory 
to another!). If you’ve suffered problems or outages, 
suggest that it’s only fair for you to be compensated 
by lower rates.
You may be required to commit to service for some 
period in order to have fees reduced. One customer 
reduced his monthly Internet cost $20, to $29.99, 
while getting about 30Mbps download and 3.5Mbps 
upload speeds -- hardly shabby, and worth agreeing 
to stick around for a year. If you’re content to remain a 
customer and don’t expect to move soon, that’s a good 
bargain. Of course, watch the calendar and haggle 
again if your rate ever increases.
Finally, if you work with a competent and helpful rep 
– whether for initial orders, account changes, service 
or billing issues – ask for direct contact information, 
both telephone number and email address.
It’s immensely helpful having continuity in dealing 
with normally faceless businesses, and service providers 
increasingly recognize how much personal service 
improves customer satisfaction. Not all companies or 
reps provide this, but -- as with everything else this 
article suggests -- it can’t hurt to ask.
This article appeared originally on the slickdeals.net Web 
site, <http://slickdeals.net/>. (c) Gabriel Goldberg 2010. 
Permission is granted for reprinting and distribution by 
non-profit organizations with text reproduced unchanged 
and this paragraph included. Please email slickdeals@
gabegold.com when you use it.



Microsoft Security Essentials - 
Free Anti-Malware Protection

by Ira Wilsker
WEBSITE:
http://www.microsoft.com/Security_Essentials

I recently encountered a situation where one of my 
computers was unable to load a new beta (pre-
release) version of one of the popular security 

software suites that I was beta testing. The purpose of 
beta testing is to find serious bugs and other problems 
before the software is officially released.  I have been a 
beta tester for dozens of titles over the years, and am 
fully cognizant of the problems and risks of beta test-
ing. While the  software publisher’s beta support team 
has not yet resolved my issue, which was repeatable, 
this particular computer was now lacking any security 
software, and was at risk while performing normal 
online and offline tasks.  I could have reinstalled my 
previous security suite, which has proven itself as reli-
able and effective, but I decided that this would be a 
good opportunity to try something new.  There are a 
lot of security utilities available, both commercial and 
free, so I decided to try one of the few free products 
that I had not tried on one of my personal computers.  
I decided to try Microsoft’s Security Essentials.
Microsoft had sold online and through retail chan-
nels its previous security product, Windows Live 
One-Care, which was met with mixed reviews re-
garding its level of protection and performance.  In 
late 2008 Microsoft announced that it would discon-
tinue Windows Live OneCare on June 30, 2009, and 
replace it with a new offering code named “Morro”.  
“Morro” was released in its final version in 2009 for 
free distribution and download as Microsoft Security 
Essentials.  This product is available for download di-
rectly from Microsoft at www.microsoft.com/Secu-
rity_Essentials.  As is common with almost all other 
Microsoft services, Microsoft will digitally determine 
the validity of the Windows installed on the com-
puter before allowing the download; this process only 
takes a few seconds.  Security Essentials will run on 
almost any Windows computer with a genuine copy 
of XP (Service Pack 2 or SP3), Vista (Service Pack 1 
of SP2), or Windows 7.  Versions are available for ei-
ther 32 bit or 64 bit operating systems.  Since Security 
Essentials is an integrated anti-malware product that 
protects from both viruses and spyware, it will dis-
able Windows Defender (Microsoft’s dedicated anti-
spyware utility) if Defender is already installed on the 

See Microsoft Security next page
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computer.  Unlike other competitive security suites, 
Security Essentials does not include a firewall, but in-
stead activates Window’s integral firewall, and works 
with it.  Also, since this is an “Essentials” utility that 
only provides malware protection, it does not include 
most of the other enhancements incorporated into 
the commercial products, such as anti-spam, website 
protection, and other tools.  Security Essentials is 
ICSA Labs certified, and has been awarded the VB 
100 Virus label, meaning that it detected 100% of the 
threats in a standardized testing environment.  This 
is important as it indicates that Security Essentials 
does an acceptable job in protecting systems from 
malware.
Downloading Security Essentials directly from 
Microsoft was very fast, the 64 bit version only being 
about 7mb in size.  Installing it was simple, but it did 
recognize that I had some other security software on 
the computer, and directed me to uninstall the other 
software before installing it.  Once I uninstalled the 
other security software that it identified, Security Es-
sentials installed very quickly, and did not present any 
complicated configuration questions.  After installing 
the program, it asked to perform an update, and then 
completed a quick scan of my hard drive.  The scan 
was very fast, among the quickest that I have experi-
enced, a plus for Security Essentials.
The interface for Security Essentials is clean, with few 
options available.  The “Home” screen shows if the 
real-time protection is on, and if the signature files 
are up to date.  Also on the Home screen are buttons 
for a quick, full or custom scan.  The “Update” screen 
shows the date and time that the definitions were cre-
ated, as well as virus definition and spyware definition 
version numbers.  The “History” screen shows threats 
that were detected, quarantined, or allowed.  Under 
the “Settings” tab, the screen shows the scheduled 
scans, file exclusions, some simple “Advanced” set-
tings, and an ominous selection “Microsoft SpyNet”.  
Microsoft SpyNet is an online community that helps 
the user respond to threats.  By default, Security Es-
sentials sends basic information to Microsoft about 
any possible malware that was detected.  One inter-
esting statement on the SpyNet setting says, “In some 
instances, personal information might unintentionally 
be sent to Microsoft.  Microsoft will not use this in-
formation to identify you or to contact you.”  The “Ad-
vanced membership” is basically the same, but sends 
additional software information to Microsoft.  
One setting that is missing in Security Essentials that 

is on almost all other security products, is some type 
of setting to determine how often the software should 
“phone home” to check for updates.  Microsoft says 
that it automatically updates, but does not indicate 
any standardized frequency of updates.  My former 
security suite by default checked for updates every 
hour, and another product that I have used “pushes” 
almost continuous updates to the user, keeping them 
reasonable up to date.  By contrast, Security Essentials 
has an apparently unpredictable update pattern, such 
that today I received a warning on the task bar icon, 
which flashed red; clicking on the icon told me that 
my definition files (virus signature files) may be out 
of date.  Looking at the “Update” tab on the program 
showed that my files were two days out of date, so 
I manually updated the software by clicking on the 
“update” button.  The update was quickly download-
ed and installed, but it was interesting to note that 
the time stamp on the latest update was about six 
hours old.  As I type this, the “Update” screen shows 
that my definitions are over 10 hours old, so I just 
clicked on the update button again; Security essen-
tials duly checked for an update, and reported that 
my software is up to date, but still shows the 10 hour 
old definitions as being the latest.  Several years ago, 
daily updates were the industry norm, but today, with 
thousands of new threats appearing daily, infrequent 
updates may indicate a potential weakness in system 
defenses, as competitive software would have already 
been updated several times today.
One very pleasant surprise with Security Essentials 
is how fast it loads at boot, and how little it degrades 
system performance.  I use a software utility called 
Soluto to monitor and control my boot process; us-
ing my prior security suite, boot time was about 100 
seconds, but with Security Essentials, my computer is 
booting in about 50 seconds, or twice as fast!  Like-
wise, programs seem to load much faster with Secu-
rity Essentials than my previous product, and browser 
performance is greatly improved as well, with web 
pages loading much faster.  This may be explained by 
the fact that since Security Essentials is precisely what 
its name implies, only the basic essentials load;  other 
overhead is not loading and running like the more 
comprehensive competitive security suites.
It is up to the user to decide if the minimal but ad-
equate protection provided by the free Microsoft 
Security Essentials is worth the significant improve-
ments in performance that it allows. Since my per-
sonal choice is to have increased protection, even at 
the cost of some performance degradation, I will go 
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back to my favorite comprehensive commercial suite 
as soon as the beta issues are resolved, or the final ver-
sion is released.  Still, in the meantime, I will stay with 
Microsoft Security Essentials until that time.



Microsoft Security from previous page

WolframAlpha - 
Computational Knowledge 
Engine

by Ira Wilsker
WEBSITES:
http://www.wolframalpha.com
http://www.wolframalpha.com/examples/
http://www.wolframalpha.com/screencast/
introducingwolframalpha.html
http://www.wolframalpha.com/about.html
http://www.wolframalpha.com/downloads.html

We are all familiar with the common 
search engines, such as Google, Bing, 
AllTheWeb, and Yahoo.  There are hun-

dreds, if not thousands, of search engines, and they all 
pretty much provide somewhat the same information.  
Last year Microsoft introduced Bing,  its latest search 
engine iteration, which also had some decision mak-
ing capabilities and built-in intelligence.  Microsoft 
used its power and wealth to inundate the computing 
world with information and promotional materials 
about Bing in an attempt to steal market share from 
Google and the other major search engine provid-
ers.  At about the same time (May 15, 2009), a much 
smaller company, Wolfram Research, the publisher of 
the Mathematica software, introduced its computa-
tional knowledge engine WolframAlpha. 
WolframAlpha is not a traditional search engine that 
displays listings of web links, but instead displays the 
answer to a question, formula, or other inquiry.  For 
example, if I type “Beaumont  Texas” in Google, I am 
presented with a listing of nearly 7 million web links 
containing the term “Beaumont Texas”, with some 
rank ordering placing the most popular results near 
the top of the display.  If I type “Beaumont Texas” in 
the search box on WolframAlpha (www.wolframal-
pha.com), it directly displays the facts about the topic.  
In this case, WolframAlpha displayed the population, 
map, current local time and weather, cost of living in-
dex, median home price, unemployment rate, sale tax 

rate, crime rate, commute time, geographic informa-
tion, links to the county and nearby cities, and a hy-
perlinked list of famous people born in Beaumont.
WolframAlpha displays a lot more than just text, as it 
is a powerful computational engine.  There is an entire 
menu consisting of hundreds of sample inquiry topics 
at www.wolframalpha.com/examples, and some other 
suggestions in the margins of several of the pages that 
the user can utilize to practice on the system, and 
master some of its powerful features.  One of the sug-
gested sample ideas is to enter the user’s date of birth; 
I entered mine and was presented with a lot of infor-
mation about my birthday.  The results showed my age 
in years, weeks, and days; holidays and observances 
that are held on my birthday;  historical events that 
occurred on that day (not necessarily in the same year) 
and a listing of celebrity and historical figures who 
were born or died on that day.  Other information is 
displayed about the selected date, including the moon 
phase on the day I was born.  By entering one or more 
stock symbols, a wealth of information is displayed.  
As a test, I entered the symbol “VZ” for Verizon, and 
was presented with current price information, finan-
cial fundamentals, dividend and yield, historical re-
turns, a large variety of charts, performance compari-
sons between Verizon and it competitors, histograms, 
and other detailed information about the company.
WolframAlpha is one of the handiest and most in-
formative calculators available.  Using the example 
“$250 + 15%” displays both the result ($287.50) and 
how it was calculated; this could be a great tool for 
teaching basic arithmetic.  Mathematical formulae are 
computed with ease, displaying detailed results of the 
computation.  Using the digital term “ x^2 sin(x)” (x 
squared times sine of x) displays graphical plots on 
various scales, alternate forms of the mathematical 
expression, roots, derivatives, and other functions.
Math and simple facts are not the only computational 
capabilities of this excellent service; it also has hun-
dreds of other forms of information that can be cal-
culated and displayed.  Other areas in which Wolfra-
mAlpha can provide extensive information are statis-
tics and data analysis, physics, chemistry, engineering, 
astronomy, earth and life sciences, money and finance, 
dates and times, places and geography, socioeconomic 
data, weather, health and medicine, food and nutri-
tion, sports and games, music, and many other top-
ics.  Users of my weather page sometimes ask me for 
historical weather information, usually for a specific 
date and location; as a default, WolframAlpha uses 
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the location of the computer requesting the informa-
tion, which is in my case, Beaumont.  I simply entered 
“weather summer 2008” (for other locations enter the 
city or other geographic information), and was pre-
sented with time and temperature ranges, humidity, 
graphs showing meteorological information, and in-
formation about the weather stations that gathered 
the information presented.  I picked this particular 
search to display the effects of Hurricane Ike, such 
as the wind speed and barometric pressure, which 
conspicuously stand out on the graphs.  Using the 
hurricane template under the topics menu, the user 
is presented with detailed information on a particu-
lar storm, wind speeds, and comparisons.  Using the 
comparison feature, I compared Rita to Ike by enter-
ing the search term, “Hurricane Ike, Hurricane Rita”, 
and was presented with a table comparing those two 
local disasters.  Rita was the stronger storm, but ac-
cording to the composite tracking chart displayed, 
both had nearly identical tracks.
The amount of computational knowledge available 
from WolframAlpha is almost endless.  If the user 
needs to calculate monthly payments and an amorti-
zation table, this can do it.  If an investor needs com-
modity and futures prices, WolframAlpha provides 
that information in detail.  Mortgage terms can be 
directly compared; by searching with the expression, 
“mortgage $150,000, 6.5%, 30 years” produces charts 
and graphs that display the monthly payments, graph-
ical comparison of principle and interest over time, 
and other information.  Present values, currency con-
versions, bond evaluations, different forms of options 
and derivatives, salaries, wages, income taxes, sales 
taxes, and historical financial information are easy 
to determine with WolframAlpha.  In the econom-
ics classes that I teach every semester, the students 
are asked to calculate what has happened to prices 
over their lifetimes, and what may happen to prices 
when they are ready to retire.  Using this engine the 
students can instantly calculate the current value of a 
historical quantity of money ($1000 in 1965 is worth 
what today?), compute historical equivalent value of 
today’s money ($1000 today compared to 1980), and 
convert one historical quantity of money to another 
($1000 in 1945 was worth what in 1990?). 
While WolframAlpha is accessible from any internet 
browser, it is also accessible using other means, with-
out a browser, or as a browser plug-in to automate 

WolframAlpha from previous page the computational process.  From the website at wol-
framalpha.com/downloads.html, the user can put a 
gadget, widget, or deskband on his desktop (Mac OS 
X, Vista and Windows 7) to enable him to access in-
formation directly from his desktop.  WolframAlpha 
toolbars are available for Internet Explorer, Chrome, 
and Firefox which enable searching from the browser 
toolbar.  Firefox and IE8 users can add WolframAl-
pha as a search engine add-on, automating the search 
function from the browser menu.  Apps (applications) 
are available for the iPhone, iPad, and iPod Touch 
that enable users of those devices to directly access 
the capacity of this service.  Regardless of how ac-
cessed, the massive capabilities of WolframAlpha are 
readily available.
Now that I have had some experience with Wolfra-
mAlpha, I will be more likely to use it to acquire in-
formation and calculate data, and less likely to use 
the traditional search engines such as Google when 
I need to find something.  WolframAlpha is one of 
those services that I did not originally know that I 
needed, but now I cannot do without it.


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Variations On a Theme of 
Flash Drives

Reviewed by Fred Wasserman, Vice President, 
Programs

Seniors Computer Group, California
December 2009 issue, Bits and Bytes

www.scgsd.org / scgsd (at) cox.net 

Flash drives have become not just interesting 
little toys but essential storage and data trans-
fer tools. How many of us still use floppy disks 

to pass data along from one computer to another? 
They fit in a shirt pocket. For bigger stacks of data, a 
CD or DVD was necessary, but didn’t fit in that shirt 
pocket. When flash drives came along disk media 
were relegated to just long-term storage or for send-
ing data by mail. Flash drives in use is doubling every 
year. That means there is a real opening for manufac-
turers to come up with newer and better versions of 
the product.
I came into pos-
session of some 
really interesting 
and useful varia-
tions on the flash 
drive, or thumb 
drive, as it is 
sometimes called. 
They both held my 
interest as very useful devices. One is so small and flat 
that it can easily be put in your wallet where it would 
probably make less of a bulge than a folded dollar bill. 
Great idea. They both come equipped to clip on to 
your key chain. The larger one, called “TUFF-CLIP” 
has a retractable protector on the connector end and 
a spring latch to connect to anything like a key ring. 
The little 
one, called 
“TUFF-N-
TINY” can 
also be at-
tached to a 
key chain 
with the 
s u p p l i e d 
lanyard. A 
c o n s i d e r-
ation with 
that USB 
Drive is you 

must remember to keep the contacts facing up when 
connecting it to the USB port, though it won’t suffer 
damage if you don’t.  
It doesn’t just stop there. The TUFF-N-TINY is com-
pletely sealed, water and dust resistant, measures just 
1 by ½ inch and is no thicker than a penny and offers 
2, 4 or 8 Gb of storage for $12 to $27. Until now, the 
one flash drive weakness was their fragility. These are 
complex little devices with their delicate circuit board 
components within some kind of brittle plastic casing 
soldered to the external connector. But this Verbatim 
product addresses the fragility problem by design and 
elimination of the weakest 
point, the connector-to-body 
attachment. The connector, 
electronics and housing are 
just a single strong plastic 
potted circuit board.
TUFF-CLIP, the other in-
novative USB drive, is an extremely tough unit that 
is designed for extreme environments and can be 
clipped to backpacks, belt loops key chains or what 
have you.
As an added convenience, both come with the ap-
plication built in to encrypt the data contents in any 
Windows environment. If lost or stolen, your data is 
safe but only if you use that capability.
Last, but in no way least, is that these USB drives are 
enhanced for users of the newer versions of Windows. 
They are Readyboost capable. You will ask, what is 
Readyboost?  With Widows Readyboost which is 
available with Windows Vista and Windows 7, you 
can use appropriately designed USB flash memory 
to improve performance without having to add ad-
ditional memory to the computer internals. The flash 
drive acts as the additional memory cache that, like 
your installed RAM, can be accessed faster than hard 
drive storage. Visualize 4- or 8-Gigabytes of addi-
tional memory to speed up your large file-intensive 
programs such as working on a large Photoshop im-
age.
Verbatim, producer of the old - 5.25 inch floppy that 
my first computer ran from has added these new 
products to its expanding line of useful media and is 
still making the good stuff.


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